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1. INTERFACE
1.1. Chronos project

1.2. Window arrangement
1.3. General options
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1.1. CHRONOS PROJECT
• "File"
• "New project“
OR
• “Open project” to load an existing project.

New project:
Using the interface:
1. Select a machine template from the list 

(Example: “3 axis-Fanuc”).
2. Specify a project name. This name will be the 

name of the Chronos project.
3. Load an NC Program.
4. Load a stock model.
5. Choose a project directory, where Eureka will 

create the project structure for the Chronos 
project.

6. “Ok”
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1.1. CHRONOS PROJECT
Few seconds and the Chronos project will appear 
automatically.

Remember to check the message window for errors 
or problems. If the messages are only blue 
(communications) everything is correct.

To check the “STOCK” geometry, remember to:
• “View”
• “Stock window”

NOTE: In Chronos, the finished parts and the fixtures 
are not considered/imported.
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1.2. WINDOW ARRANGEMENT
• «View> Click on the checkbox» to hide / show the necessary windows.

Check:
• Toolbar
• Message bar
• Machine preparation bar

• Drag the title bar of the listed windows to view the anchor points.
• Move the mouse over the anchor point to constrain the window and thus compose your work environment.
• At any time, it will be possible to undock the windows and change their arrangement.
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1.3. GENERAL OPTIONS
• «View> Options»

• "General"
• Select "Language"

• Choose the language.
• Restart the application to apply the 

changes.

• "3D navigation"
• Create a new profile and modify the keys to 

customize the navigation mode.
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2. PROJECT CONFIGURATION
2.1. Configure optimizer

2.2. Program
2.3. Playlist configuration

2.4. Subprograms
2.5. Workorigins

2.6. Absolute origin – G53
2.7. Tools

2.8. Workpiece
2.9. 3D model import reference
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2.1. CONFIGURE OPTIMIZER
• "Setting"
• "Configure optimizer"

• "Performance index": drag the "Tool life / 
Productivity" bar to change the performance of 
the optimizer.
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2.1. CONFIGURE OPTIMIZER
• "Setting"
• "Configure optimizer"

• "Performance index": drag the "Tool life / 
Productivity" bar to change the performance of 
the optimizer.

Max override in air (%): maximum percentage of 
increment for the movements in air (Ex: 200% of the 
programmed federate).

Max override in the material (%): maximum 
percentage of increment for the movements in the 
material (Ex: 120% of the programmed feedrate).

Min override in the material (%): minimum 
percentage of increment for the movements in the 
material (Ex: 80% of the programmed feedrate).
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2.1. CONFIGURE OPTIMIZER
• "Setting"
• "Configure optimizer"

• "Performance index": drag the "Tool life / 
Productivity" bar to change the performance of 
the optimizer.

Maximum Airspeed (MMPM): maximum speed for 
movements in air (Ex: 40000 mm/min). Remember 
to check the box to turn on the option.

Maximum Cutting Speed (MMPM): maximum limit 
for the working movements (Ex: 2000 mm/min).

Do not add intermediate movements: Chronos will 
not create intermediate movements between two 
lines of the NC code.
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2.1. CONFIGURE OPTIMIZER
• "Setting"
• "Configure optimizer"

• "Performance index": drag the "Tool life / 
Productivity" bar to change the performance of 
the optimizer.

In case of material removal negligible or material 
removal variation too small.

Max override in the material (%): maximum 
percentage of increment for the movements in the 
material (Ex: 110% of the programmed feedrate).

Min override in the material (%): minimum 
percentage of increment for the movements in the 
material (Ex: 90% of the programmed feedrate).
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2.1. CONFIGURE OPTIMIZER
In case of material removal negligible or material 
removal variation too small, a small icon (bell) with 
a red dot, will appear close to “Mode”, inside the 
“Feedrate optimizer” window.

Moving the mouse on the icon, Chronos will show 
the message.

In this case, Chronos will use the previous options to 
optimize the code.

Use:
• “Max override in the material” = 100
• “Min override in the material” = 100
To NOT optimize these movements.
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2.1. CONFIGURE OPTIMIZER
• "Setting"
• "Configure optimizer"

• "Performance index": drag the "Tool life / 
Productivity" bar to change the performance of 
the optimizer.

Results.

• Check «Save optimization report in excell
format»: generate an «.xlsx» (Excel) file when the 
new ISO program is generated.

• Check "Optimize lines performed several times 
using the first run analysis": apply the 
optimization algorithms only on the first line of a 
series of equal movements.
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2.2. PROGRAM
Using the command “New project”, Chronos will add automatically 
the Program file. Is possible to change it, following this procedure:

Make sure you have clicked on the «Stop simulation» button.

• DX click on «Program».
• «Edit».
• Select the ISO file you want to use as the main 

program.
• When the upload is complete, the program 

window will be shown.

Is NOT possible to modify the loaded program.

It will be possible to position the Program window by 
dragging it from the title bar and using the anchor 
points that will be shown in the 3D view.
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2.3. PLAYLIST
Make sure you have clicked on the «Stop simulation» button.

• Left click on «Playlist».
• Right click on the page below the machine 

preparation (yellow window)
• «Add program to simulate».
It will be possible to load more than one program at 
the same time.

At the end of the simulation of the first program, 
Chronos will perform automatic operations. After 
that, it will run the next program in the list.
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2.3. PLAYLIST
• Right click on the loaded programs:

• «Delete»: 
• «Insert/remove breakpoint»
• «Remove all breakpoints»: 
• «Disable simulation»

• «Properties»
• “Auto”: Chronos will simulate all the 

loaded programs until the end. At any 
time, the User can stop the simulation 
clicking on the “Pause” icon and run the 
optimizer (add a breakpoint at the end 
of a program to stop the simulation and 
analyze the results).

• “Open Chronos window”: at the end of 
each loaded program, Chronos will 
open the optimizer and will show the 
results (good for the initial test).
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2.4. SUBPROGRAMS
Make sure you have clicked on the «Stop simulation» button.

• DX click on "Subprograms"
• «Edit».
• "Add" command to load a specific macro or 

subroutine.
• The latter will be shown in the list of available 

macros / subroutines.

In the program window, click on the «File» list to 
view the contents of the available macros.

In the case of new macros, used for any future 
project, it will be necessary to contact your technical 
reference to modify the template file of the machine 
used.
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2.4. SUBPROGRAMS
• “Settings”
• “Optimizable programs”

Check the “Optimizable programs” window to turn 
on/off the programs and subprograms that the user 
want to optimize.

• Click on the checkbox to turn on/off the 
optimization.

At the end of the optimization, inside the «opt_...» 
folder, Chronos will save the selected optimized
subprograms.
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Make sure you have clicked on the «Restart» button.

• Right click on «Work origins»
• «Edit».
• Click on «Add», to create a new origin.
• Double click on the "Name" field to change the origin code (G54, O1, etc ...).
• Double click on the “X, Y or Z” field, to modify the values.
• Click on «Restart» to see the updated position of the origin.
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• Right click on the “X, Y or Z” field to directly capture the origins on the STL geometries of the machine or part / 
equipment.

• «Center by 3 points»: select 3 vertices to acquire the center of a circle by 3 points.
or
• “Select vertex": select 1 vertex. The coordinates of the origin will be equivalent to the coordinates of the 

selected vertex.
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2.6. ABSOLUTE ORIGIN – G53
• «View > Stock window»
Keep this window opened to check the references.

How to change the G53:
• «Settings»
• «Set the machine zero»

This tern represents the reference for 
absolute movements (Ex. G53 G0 X100).

G54 : this reference is already changed using
«Machine setup > Work origins»

This tern represents the reference for 
movements in work (Ex: G54 G0 X100).
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• Right click on "Tools"
• «Edit»

The geometry of the cutting and non-cutting parts can be recreated in Chronos, thanks to parametric shapes and 
/ or 3D «.stl» models.
(In terms of performance, parametric shapes return the best results).
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2.7. TOOL DATABASE



• Use the “Import from folder” icon to use and import an existing tool database from a folder.

Consult the document «Eureka10_DATABASE_TOOLS_eng» for more information about the creation of 
parametric tools, shaped from 2D profiles, 3D models, or revolution and extrusion.
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2.8. STOCK (WORKPIECE)
Using the command “New project”, Chronos will add automatically 
the Stock model. Is possible to change it, following this procedure:

Make sure you have clicked on the «Stop simulation» button.

• Left click on «Stock».
• Right click in the window below the "Machine setup" 

(yellow window)
• «Add > Shape from file» to load a 3D model 

(preferably in «.stl» format) previously exported 
from CAD or CAM.

OR
• «Add» and select one of the available parametric 

shapes.

• Right click on the name of the newly imported shape
• «Properties»: the properties window will be displayed, in 

order to change the position, scale, color and transparency 
of the 3D model.

• “Save”: is possible to save a machined stock file. The 
format can be “.stl” / “.estk5” / “.wrl”
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2.9. 3D MODEL IMPORT REFERENCE
• «View > Stock window»
Keep this window opened to check the references.

The 3D model of the stock is imported using as
global origin, the dashed tern.

For the «Shape from file», the 3D model will be 
imported with the same reference used in the CAD 
software.

For the «Parametric shape», is important to choose
the global reference, inside the «Properties».

To reduce the number of steps to fix the workpiece
position, is suggested to export the 3D models from 
CAD already in a good position.
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3. OPTIMIZE THE FEEDRATE
3.1. Pre-analysis

3.2. ISO program analysis
3.3. Open the feedrate optimizer

3.4. Change the parameters of the optimizer
3.5. “A.I.”

3.6. “User”
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3.1. PRE-ANALYSIS
Make sure you have clicked on the «Stop simulation» button.

• Click on the "Pre-analysis" icon
• “Restart"
Chronos will begin a fast analysis of the imported 
NC program.

Once the pre-analysis is finished, by clicking on the 
"Simulate without display" icon, Chronos will show:
• Time spent in simulation.
• Estimated simulation time.
• Time remaining to complete the simulation.

Check the message window, locate the "Simulation" 
option and select "Pre-analysis".
Chronos will show the result of the pre-analysis.
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3.2. ISO PROGRAM ANALYSIS
«Restart»: restores the machined model and 
restores the simulation to its initial state.

«Terminate simulation»: stop the simulation and 
allows to import new 3D models, new programs or 
perform some operations.

«Simulate and analyze»: start analyzing the ISO 
program.
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3.3. OPEN THE FEEDRATE OPTIMIZER
• “Feedrate optimizer" menu
• "Open feedrate optimizer"

OR

• Select the "Open Chronos" icon

Following the analysis of the NC program, by 
opening this window, the first optimization results 
will be shown.
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3.3. OPEN THE FEEDRATE OPTIMIZER
On the top left of the “Federate optimizer” window, 
right click on a tool in the list to:
• “Copy parameters”. After that, is possible to 

right click on another tool ad “Paste 
parameters”.

(The «Paste paramaters» command works with 
multiple selection too).

• «Optimization» the user can switch between the 
different «Mode» strategies (A.I., User, Not 
enabled).
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"Mode":
• "Not enabled": the optimization will not be applied for this specific tool.
• "User": the parameters entered manually by the Chronos user will be used to optimize the ISO program 

associated with this specific tool.
• "Artificial Intelligence": Chronos will exploit artificial intelligence. The user will only have to choose whether to 

adopt a more conservative strategy (Tool) or whether to give priority to performance and time savings 
(Productivity).

32

3.4. CHANGE THE PARAMETERS OF THE OPTIMIZER



• Drag the “Performance index” bar to change the result of the optimization.
• “Tool life”: minimum performance to reduce the tool wear.
• “Productivity”: maximum performance and the maximum increment of the federate to save time.

The other parameters are the same to the other “Mode”.
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3.5. «A.I.»



• Specify the volume rate (cm^3/min).
• Chronos will apply the other parameters to keep more constant as possible the volume.

The other parameters are the same for the other modalities.
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3.6. «User»



4. ANALYSIS OF THE RESULTS
4.1. Percentage of saved time

4.2. Removed volume and feedrate graph
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4.1. PERCENTAGE OF SAVED TIME
«Before»: original working time, without 
optimizations.
«After»: optimized working time.
"Save": Percentage of savings (time) regarding the 
analyzed tool.

In the list, on the left, click on each tool to analyze 
the different results.

• Change the parameters or drag the A.I. bar.
• Click on «Apply».

The results will be updated again, showing the 
removed volume and progress graphs and the new 
savings value for the specific tool.
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• Hover the cursor over one of the two available graphs to get information about the original / optimized feed 
rate or the volume removed per original / optimized time unit.

• Drag the grey bars to the side and bottom of the graphs to change the scale of the graph and 
increase/decrease the amount of information shown.
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5. DATA BACKUP 
5.1. Save the optimized program

5.2. Save backup
5.3. «HELP»
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To the left of the "Save optimized programs" command, it will be possible to read and customize the name of the 
optimized program.
Click on «Save optimized programs» to generate the optimized code.

When the user click on the “Restart” simulation icon, Chronos will change automatically the name of the saved program with a combination of 
letters and numbers (name-hour/minutes/seconds).

If the user want to overwrite the results, the name of the optimized code must be the same to the previous one.
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5.1. SAVE THE OPTIMIZED PROGRAM



5.1. SAVE THE OPTIMIZED PROGRAM
On right, a short example of an optimized program in 
Chronos.

Is possible to see the changes with the feedrate and 
the moviments in air.

This picture is a good example to understand how
Chronos works with the movements in work and the 
movements in air,
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5.2. SAVE BACKUP
• "File"
• "Save backup"
• Indicate the location where the backup folder will 

be generated.

"Backup" means a folder containing all information 
and files used by Chronos.

The backup generated by Chronos can also be 
opened with Eureka.

41



5.3. «HELP»
• “Help"
• “Help"

The «help» document is a good solution to find
informations about Chronos.
Tool database, functionalities and procedures.

The language of the options depends to the system 
language.

The language of the contents, depends to the 
Chronos language.
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